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What is R?

R is a free, open source programming language

R is an integrated suite of software facilities for data manipulation,
simulation, calculation and graphical display

R runs on a wide variety of platforms such as Linux, Windows, and
macOS

The R project web page http://www.r-project.org
http://www.r-project.org
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Why R?

Handles and analyzes data very effectively

Contains a suite of operators for calculations on arrays and matrices

Has the graphical capabilities for very sophisticated graphs and data
displays

An elegant, object-oriented programming language

The use of variables, loops, merging operations and data sets, as well
as downloadable add-on packages to enhance functionality, make the
R programming options powerful and endless

R is one of the most widely used language in Bioinformatics
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Rstudio

RStudio is a convenient interface and allows the user to run R in a more
user-friendly environment

http://www.rstudio.com/products/rstudio/download/
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RStudio

R Studio is a IDE with 4 Windows on the main screen

Code: for coding / code checker

Console: coding calculations and display results

Work Space: list of objects and calculations that are created

Five tab window

Files: stored and imported files
Plot: displayed area, graph view selection, export option
Packages: list of packages installed on system, option to search and
install other packages
Help: more information about functions, arguments, user manuals, etc
Viewer: used to view local web content such as widgets, rCharts, and
applications
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RStdio
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RStdio
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RStdio
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RStdio
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RStdio
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R

R is a case-sensitive, interpreted language

For example, a and A are two different objects.

Two ways to run R command

Enter commands into the R console window at the command prompt
(>)
Create R-scripts in an editor and save them in a file (filename.R) for
later re-use.
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Getting Started with R

Data management

Data importing.
Write data into files.
Save data as an image.

Data process

Types of data.
Arithmetic of data.

Functions

Packages

Instructor: Mary Yang, PhD (Graduate Assistant: Dan Li and Yifan Zhang) August 2, 2017 12 / 70



Data Import

Data can be entered from the console.

Larger data often be read as values from external files rather than
entered at the keyboard.

Different data formats that can be imported into R and different
functions to call them.

.csv

.txt
HTML table
Excel
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Data Import

CSV

df = read.csv(file_name.csv)

df = read.csv2(file_name.csv)

TXT

df = read.table(file_name.txt)
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Building-in data set in R

R also contains many datasets that are built-in to the software

These datasets are stored as data frames. To see the list of datasets,
use

> data()

Then, a window will open and the available datasets are listed
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Building-in data set in R : an example

Example: to open the dataset called Orange

> data (Orange)

After doing so, the data frame Orange is now in your workspace.

# To learn more about this data, type

> ?Orange

> Orange

Tree age circumference

1 1 118 30

2 1 484 58

3 1 664 87

4 1 1004 115

5 1 1231 120

6 1 1372 142

7 1 1582 145

8 2 118 33

9 2 484 69

10 2 664 111
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Data Export

CSV:

write.csv(data, file = "path/file_name.csv")

TXT

write.table(data, file = "path/file_name.txt", row.names =

FALSE, col.names = TRUE)

The argument row.names = FALSE makes that no row names are
written to the file. Because nothing is specified about col.names, the
default option col.names = TRUE is chosen and column names are
written to the file.
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help

More options

help (write.csv)

?write.csv

?write.table
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Saving Data

Save the data into image for reuse by R

save(data, file = "data.RData")

load("data.RData")
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Data process: computing with R

When variables are used, they need to be initialized with numbers.

R can take as arguments for its functions single numbers, vectors,
matrices, or data frames.

The assignment operator is “←”. Alternatively, as of R version 1.4.0,
you can use “=” as the assignment operator.

A = 5

A <- 5
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Data Types

Types Examples
Integer: Natural numbers 1, 2, 3

Numeric: Decimal values 1.5, 2.2, 3.7

Logical: Boolean values TRUE or FALSE (T or F)

Character: Text or string values ”cat” ”blue”
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Data Structures

R has a wide variety of data structures:

vector
matrix
data frame
list
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Vector

# numeric vector

x = c(1,2,5.3,6,-2,4)

#character vector

y = c("one","two","three")

#logical vector

z = c(TRUE,TRUE,TRUE,FALSE,TRUE,FALSE)
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Vector

#replicates the values in x

> a = rep (1, 6)

> a

[1] 1 1 1 1 1 1

#Generate regular sequences.

> a = seq (1, 6)

> a

[1] 1 2 3 4 5 6

#Or

> a = 1:7

> a

[1] 1 2 3 4 5 6 7
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Vector

You can refer to elements of a vector using subscripts.
> a

[1] 1 2 3 4 5 6

> a[2] #Access the second element of the vector

[1] 2

> a[c(2,4)] #Access the second and fourth elements of the vector

[1] 2 4

> a[1:3] #Access the first three elements of the vector

[1] 1 2 3
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Matrix

All columns in a matrix must have the same mode(numeric,
character, etc.) and the same length. The general format is

matrix(vector , nrow = r , ncol = c , byrow = FALSE , dimnames =
list(char vector rownames, char vector colnames))

byrow = TRUE indicates that the matrix should be filled by rows.

byrow = FALSE indicates that the matrix should be filled by columns
(the default).

dimnames provides optional labels for the columns and rows.
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Matrix

# generates 3 * 5 numeric matrix

> x = matrix(1:15, nrow=3,ncol=5)

#Default byrow=FALSE

> x

[,1] [,2] [,3] [,4] [,5]

[1,] 1 4 7 10 13

[2,] 2 5 8 11 14

[3,] 3 6 9 12 15

Instructor: Mary Yang, PhD (Graduate Assistant: Dan Li and Yifan Zhang) August 2, 2017 27 / 70



Matrix

# another example

> cells = c(1,26,24,68)

> rnames =c("R1", "R2")

> cnames = c("C1", "C2")

> m = matrix(cells, nrow=2, ncol=2, byrow=TRUE,dimnames=list(

rnames, cnames))

> m

C1 C2

R1 1 26

R2 24 68
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Matrix

You can identify rows, columns or elements using subscripts.

#4th column of matrix

> x[,4]

# 3rd row of matrix

> x[3,]

# rows 2,3 of columns 1,2,3

> x[2:3,1:3]
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Data Frame

A data frame is more general than a matrix, in that different columns can
have different modes (numeric, character, factor, etc.)

> d = c(7,9,5, 20)

> e = c("red", "white", "red", NA)

> f = c(TRUE,TRUE,TRUE,FALSE)

> mydata = data.frame(d,e,f)

#Assign columns name

> colnames (mydata) = c("ID", "Color", "Status")

> mydata

ID Color Status

1 7 red TRUE

2 9 white TRUE

3 5 red TRUE

4 20 <NA> FALSE
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Data Frame

There are a variety of ways to access the elements of a data frame.

# columns 2,3 of data frame

> mydata[,2:3]

Color Status

1 red TRUE

2 white TRUE

3 red TRUE

4 <NA> FALSE

# columns ID and Color from data frame

> mydata[,c("ID","Color")]

#Column ID

> mydata$ID
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List

A list is an ordered collection of objects (components).

A list allows you to gather a variety of (possibly unrelated) objects
under one name

# example of a list with 4 components a string, a numeric vector

, a matrix, and a scalar

> mylist <- list(name="Fred", my.numbers=a, my.matrix=x, age=5.3)
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List

> mylist

$name

[1] "Fred"

$my.numbers

[1] 1 2 3 4 5 6 7

$my.matrix

[,1] [,2] [,3] [,4] [,5]

[1,] 1 4 7 10 13

[2,] 2 5 8 11 14

[3,] 3 6 9 12 15

$age

[1] 5.3
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List

Identify elements of a list using the [[]] convention.

# 2nd component of the list

> mylist[[2]]

[1] 1 2 3 4 5 6 7

# component named my.numbers in list

> mylist[["my.numbers"]]

[1] 1 2 3 4 5 6 7
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Useful Functions

# number of elements or components in a vector or a list

> length (object)

# structure of an object

> str(object)

# class or data type of an object

> class(object)

# list the variables in an object

> names(object)

# dimensions of an object, such as matrix or data frame

> dim (object)
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Useful Functions

# combine objects into a vector

> c(object,object,...)

# combine objects as columns

> cbind(object, object, ...)

# combine objects as rows

> rbind(object, object, ...)
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Data Conversion

Display the data type

> class (m)

[1] "matrix"

> class (x)

[1] "matrix"

Conversion from one type of data structures to another can easily be done

> m1 = as.data.frame(m)

> x1 = as.vector (x)
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Data Conversion

If unsure about the type, you can write

> is.data.frame(m1)

[1] TRUE

> is.data.frame(m)

[1] FALSE

> is.vector(x)

[1] FALSE
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Why data conversion
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R function: Control structure

R includes the usual control-flow statements (like conditional
execution and looping) found in most programming languages. These
include (the syntax can be found in the help file accessed by
?Control):

if(cond) expr

if(cond) cons.expr else alt.expr

for(var in seq) expr

while(cond) expr

repeat expr

break

next
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R function: Control structure

Loop: Perform the same process several times or on several variables

> for (i in 1:5){print (i)}

[1] 1

[1] 2

[1] 3

[1] 4

[1] 5
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Example: Control structure and matrix

> mat = matrix (sample (100, 50), nrow = 10)

> mat

[,1] [,2] [,3] [,4] [,5]

[1,] 93 37 16 52 75

[2,] 87 90 21 100 46

[3,] 67 27 88 33 17

[4,] 32 91 55 56 9

[5,] 26 36 31 38 47

[6,] 59 57 62 83 18

[7,] 60 66 10 79 99

[8,] 82 40 69 70 84

[9,] 74 15 35 94 97

[10,] 5 48 65 85 6
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Example: Control structure and matrix

> m1 = rowMeans (mat)

> m1

[1] 54.6 68.8 46.4 48.6 35.6 55.8 62.8 69.0 63.0 41.8

> m2 = apply (mat, 1, mean)

> m2

[1] 54.6 68.8 46.4 48.6 35.6 55.8 62.8 69.0 63.0 41.8
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Example: Control structure and matrix

> for (i in 1:10){

+ m3 = mean(mat[i,])

+ print (m3)

+ }

[1] 54.6

[1] 68.8

[1] 46.4

[1] 48.6

[1] 35.6

[1] 55.8

[1] 62.8

[1] 69

[1] 63

[1] 41.8
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Example: Control structure and matrix

Tip: when performing loop on a matrix, Basic function (fastest) → apply
(faster) → for loop (slow)

#fastest

> m1 = rowMeans (mat)

#faster

> m2 = apply (mat, 1, mean)

#slow

> for (i in 1:10){

+ m3 = mean(mat[i,])

+ print (m3)

+ }
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Example 2: Control structure and matrix

Create a matrix

> height = c(6,5,5.4,6.1,6.5,5.5,5.9)

> student = c("boy", "girl","girl", "boy","boy","boy","girl" )

> mat = data.frame (height, student)

> mat

height student

1 6.0 boy

2 5.0 girl

3 5.4 girl

4 6.1 boy

5 6.5 boy

6 5.5 boy

7 5.9 girl
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Example 2: Control structure and matrix

> for (i in 1:nrow(mat)){

+ if (mat[i,2] == "girl"){

+ print (mat[i,])

+ }

+ }

height student

2 5 girl

height student

3 5.4 girl

height student

7 5.9 girl
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Logical operators

Many of these statements require the evaluation of a logical
statement, and these can be expressed using logical operators:
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User-defined function

R users can define their own function. The general format for creating
a function is

functionName <- function(arg1, arg2, ...) { R code }

In the above, functionName is any allowable object name and arg1,
arg2, ... are function arguments.

As with any R function, they can be assigned default values.

When you write a function, it is saved in your workspace as a function
object.
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A user-written function
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User defined function

The function object f1 will remain in your workspace until you remove
it or quit R session.

You can save these commands in R script (f1.R) for later-use.
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Save user-written function for later-use

Instructor: Mary Yang, PhD (Graduate Assistant: Dan Li and Yifan Zhang) August 2, 2017 52 / 70



Users-written function: Another example

> calcu = function (a, b){

+ result = (a + b * 5) ^ 2

+ return (result)

+ }

> calcu (4, 2)

[1] 196

> calcu (0.5, 0.1)

[1] 1

> calcu ("A" , "B")

Error in b * 5 : non-numeric argument to binary operator
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R Script

It is recommended that you write and edit all of your R code in a
script before you run it in the console.

It creates a reproducible record of your work.

You can save your script and then use it to rerun your entire analysis.

Scripts are also very handy for editing and proofreading your code
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R Script

When you open an R Script (File → New File →R Script in the menu
bar), RStudio creates a fourth pane above the console where you can
write and edit your code.

RStudio comes with many built-in features that make it easy to work
with scripts.

R will run whichever line of code your cursor is on by clicking the Run
button
If you have a whole section highlighted, R will run the highlighted code
by clicking the Run button
Alternatively, you can run the entire script by clicking the Source
button.

To save a script, click the scripts pane, and then go to File → Save
As in the menu bar
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Built-In Function: numeric function
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Built-In Function: character function
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Built-In Function: statistical function
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Missing data

In R, missing values are represented by the symbol NA Test for
missing values:

#Test for missing values

> is.na (x)

#Excluding Missing Values from Analyses

> mean (x, na.rm = TRUE)

#Create a new dataset without missing data

> newData = na.omit (myData)
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R packages

R started with basic packages. To see the list of all available packages
on systems, you can type into the R console window

> library()

To install a new package, you can either click on Packages-install
package(s), or type commands into the console window:

> install.packages ("gplots") # install a package called

gplots

> library (gplots)} #load gplots packages

To update a package called gplots

> update.packages ("gplots")
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R Package
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The Workspace

All variables or “objects” created in R are stored in what’s called the
workspace

To see what variables are in the workspace, you can use the function
ls() to list them.

To remove objects from the workspace use the rm() function:

# delete a object called

> rm (X)
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Manipulating file paths in R

Pathnames in R are written with forward slashes “/”, although in windows
backslashes, “\”, are used.

#To set a working directory in R:

> setwd("Directory name")

#To print the current working directory:

> getwd()

#To show the files in the current working directory:

> dir()

#To create a directory for your project - good way to organize

your files

> dir.create("R Workshop 2017")
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Manipulating file paths in RStudio
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Getting Help

R has an extensive help facility
Apart from the Help window launched from the Help menu, it is also
available from the command line prompt
For instance

#explain about square root function

> help(sqrt)

> ?sqrt

Most of the help files also include examples. You can run all of them
by using the example()

#run all the examples from the matrix help file
> example (matrix)

#run all the examples from the plot help file
> example (plot)
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Bioconductor

Bioconductor is an open source and open development software
project for the analysis of biomedical and genomic data.

The project was started in the Fall of 2001 and includes developers in
many countries
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Bioconductor

Provide access to powerful statistical and graphical methods for the
analysis of genomic data.

Facilitate the integration of biological metadata (GenBank, GO,
Entrez Gene, PubMed) in the analysis of experimental data.

Allow the rapid development of extensible, interoperable, and scalable
software.

Promote high-quality documentation and reproducible research.

Provide training in computational and statistical methods.
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Bioconductor packages

General infrastructure

Biobase, Biostrings, biocViews

Annotation:

annotate, annaffy, biomaRt, AnnotationDbi

Graphics/GUIs:

geneplotter, hexbin, limmaGUI, exploRase

Pre-processing:

affy, affycomp, oligo, makecdfenv, vsn, gcrm, limma

Differential gene expression:

genefilter, limma, ROC, siggenes, EBArrays, factDesign

GSEA/Hypergeometric Testing

GSEABase, Category, GOstats, topGO
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Bioconductor packages

Graphs and networks:

graph, RBGL, Rgraphviz

Flow Cytometry:

flowCore, flowViz, flowUtils

Protein Interactions:

ppiData, ppiStats, ScISI, Rintact

Sequence Data:

Biostrings,ShortRead,rtracklayer,IRanges,GenomicFeatures,
VariantAnnotation

Other data:
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Bioconductor: Install packages

> source("http://bioconductor.org/biocLite.R")

> biocLite()

#Install Bioiconductor package Rintact

> biocLite ("Rintact")
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